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Quikscribe Recorder
User Manual

Welcome to the World of Quikscribe!

Quikscribe is designed to be easy to use, yet there are many features
that make it an incredibly powerful and reliable workflow system for
dictation and transcription activities.

Tutorial demonstrations are built into both the Quikscribe Recorder
and Player products under the “Help” menu, which can also help you
get started as a new user.

Online video demonstrations are also available to provide instruction
how to use certain features.

This user manual provides detailed explanation of all features and
components. We invite you to become more familiar with these
features if desired. The time spent learning advanced features such
as “Undo/Redo” will provide personal time savings for your future work
efforts.

As always, we invite your feedback, comments, and suggestions…
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Overview

The Quikscribe Transcription System consists of two separate components – the
Quikscribe Recorder and the Quikscribe Player.

A tape based system uses a machine to record audio to a tape. The tape is
generally filled, then taken to a typist who plays the tape back and types a
document.

Quikscribe Digital transcription uses the QS Recorder application to record audio
to a computer file on a PC. The file is then sent via a network to the QS Player.

There are several advantages to this:

 Since there are no tapes, a thirty-minute tape does not have to be filled
before being sent to the typist. A document as short as thirty-seconds can
be dictated and sent, and worked on immediately. Instructions to the
typist are imbedded in the document when it is sent

 No tape also means that a tape cannot be lost or destroyed.
 And if a file is misplaced on the network, a copy always exists back on the

original recording computer.

When transcription is completed, the typist prints the document or forwards it
back to the author for review.

Both the Quikscribe Recorder and Player are able to operate while other
Windows applications are used at the same time.

About the Quikscribe System
Quikscribe’s sophisticated technology provides new benefits for businesses and
training institutions around the world. Quikscribe has developed a breakthrough
in programming with its new ‘intelligent audio file’ (.iaf). This unique format has
given Quikscribe the ability to design numerous innovative features for digital
audio recording, transcription and file management.

A cross section of organizations including the legal industry, medical
practitioners, police, government departments, accountants, transcription
companies, secretarial services, organizations for the visually impaired, and
educational and training institutions are using the Quikscribe Digital Transcription
System. Apart from dictation and transcription, the Quikscribe Transcription
System is also used for technical writing, to send voice instructions, for compiling
reports and as a management and training tool.

With Quikscribe there are no tapes or tape machines, so maintenance and
distribution costs are significantly reduced. Additionally, since ‘tapes’ are now
files on a network, efficiency increases providing genuine time savings. The
reduction in expenses and increase in efficiency greatly benefit most businesses
that use transcription as part of their daily activities.

The Quikscribe Transcription System has an unconditional 30-day guarantee.

Specific information about the features and functions of the Quikscribe Recorder
and the Quikscribe Player follow.
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Quikscribe Workflow
The Quikscribe process streamlines your dictation and transcription processes.
Document production would proceed as follows.

 Dictate your document using the Quikscribe Recorder software.
 Transmit your document across your network, by email, or on a disk to the

typist.
 Quikscribe Player notifies the typist of the arrival of your document.
 The typist transcribes the document

This is very similar to a tape system and the Quikscribe Recorder controls are
similar in function to allow you to start dictating straight away. The Quikscribe
digital Transcription system is also designed to assist you in documentation and
file management, which will be described later in this document. Quikscribe is
designed to decrease your production time and improve your file management
and documentation.

Voice Recognition Option

The Voice Recognition option will automatically produce a draft text document,
either before or after the transcriptionist receives the audio file. Voice
Recognition software is additional and is required for this option to function.

Please note that “The Voice Recognition option should only be enabled if the
optional voice recognition software is installed and configured properly.
Otherwise files that are sent to transcription will not reach the intended
destination.”

Important Capabilities of Quikscribe

Additionally, the Quikscribe Recorder software has the following important
capabilities, which will be described in more detail later in this manual. Taking
full advantage of these Quikscribe capabilities will increase the efficiency of your
document production.

Insert Other Media.
Insert referenced material such as text, images, graphics, Internet
links, screen captures, etc., directly into the dictated file. These will
be made available to the typist and will eliminate the need for them
to be retyped or reconstructed.
Attach Documents
Attach documents of any type to the file. This is similar to attaching
a document to an email. The attached document will travel with the
dictated file.
Random file access
Jump to any point in the file instantly. There will be no delay when
rewinding or fast-forwarding.
Insert audio mid-file
Insert audio of any duration at any point in the file without
damaging any other part of the file.
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Undo changes
Undo changes you have made to the file, such as the last sentence
you dictated.
Redo changes
“Undo the undo” if you change your mind.

Automatic File Backup
A copy of any dictated file sent will be kept at your computer to
eliminate the possibility of the loss of the file.
Security Encryption
Files can be encrypted for security purposes.
Unlimited File Length
Files can be of any length (determined by hard disk drive space).
There is no need to fill a tape since there is no longer a tape to fill.
Remote Dictation
Dictate on a laptop or digital recorder and email the file to the
office.
Simultaneous Document Transcription
A single dictated file can be split automatically into smaller
overlapping segments and sent to multiple typists to decrease the
production time of large documents.
Dictation Metadata
Document management information is stored in the dictated file.
Information such as the matter number, the author’s name, the
duration of the file, the file number, and other metadata. The
Quikscribe Player will add to this data the typist’s name, typing
duration, etcetera. The Quikscribe Software Development Kit
(SDK) also allows integration of the Quikscribe Recorder and
Player functions into other Windows applications.
Background Operation
The Quikscribe Recorder can operate in the background behind
any other application.
File Storage and Archive
Dictation files can be archived for security and historical purposes.
This process can be automatic, and the files can be protected from
further edits.
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Requirements for System (Quikscribe and Player) Installation
The following is needed for the system to work;

 The Quikscribe Recorder software must be installed and configured on
the author’s computer.

 The driver software for the appropriate hand control must be installed on
the author’s computer.

 The Quikscribe Player software must be installed and configured on the
typist’s computer. See Quikscribe Player Manual.

 The sound card must be tested as operational on the typist’s computer.
See Quikscribe Player manual.

 If files are to be transferred across a network between computers, it must
be checked as functional and appropriate directory permissions must be
set.

 Meet minimum system requirements as listed below.

System Requirements (Minimum Recommended)
PC with Pentium 200 MHz (or greater)
256 MB Ram (minimum)
Sound Card (preferably Sound Blaster)
Windows 2000, XP, or Vista
USB 1.0 or greater
20 Meg of free disc space
CD-ROM drive
Microsoft Word or any other Windows-based word processor
Internet Access (optional)
Network Card (optional)
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Installing Quikscribe Recorder

Performing the following tasks is recommended for Quikscribe Recorder to
function properly and effectively. Performing these tasks will allow you to quickly
start using Quikscribe Recorder.

 Install Quikscribe Recorder and appropriate hand control software
 Configure Windows audio settings
 Create folders on network drive for shared access by both authors and

transcriptionists (for network installations)
 Configure Quikscribe to send files
 Register software
 Review hand control microphone training tutorial
 Set automatic file naming.

Details to complete these tasks follow.

Install Quikscribe Recorder Software and Hand Control Software

You may install the Quikscribe Recorder from an installation CD or online.

If you are using Windows 2000, XP or Vista, make sure you are logged in with
Administrator rights; otherwise you may encounter problems with the
installation. To check if you have Administrator rights, click start control
panel user accounts on your computer. Your account will have computer
administrator below it if you have Administrator rights.

To install the Quikscribe Recorder software from the online download link, open
the online download link and follow the screen prompts.

 Close all Windows applications
 Insert the Quikscribe installation CD in the appropriate CD-ROM drive.

If the CD does not auto-start within 10 seconds, double click on My
Computer on the desktop, and then double click the CD or Removable
Storage Icon.

 If the Quikscribe menu does not appear, double-click the “autorun.exe” file
to initiate the menu interface.

 Follow the on-screen instructions.
 In Main Menu click INSTALL
 In next menu click Quikscribe Recorder
 In next menu click the appropriate box for the hand control or

microphone that you are using with the Quikscribe Recorder
 The continuing menus guide you through the installation of the Quikscribe

Recorder and the appropriate hand control drivers.
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 During installation of QS Recorder, you may select the desired options to
include during installation, including Voice Recognition integration with
Dragon NaturallySpeaking, Philips DPM integration and drivers, and
integrated management features. To include the optional features,
select the “Complete” or “Custom” installation methods. The
custom “Management” option will provide workflow tracking of file
status, and the “DPM” option will include drivers for the Philips
Digital Pocket Memo portable recorder.

 Following is a list of the supported hand control devices.

Supported Hand Control Devices
Quikscribe Recorder supports several hand controls. Drivers
for most of these hand controls are on the Quikscribe
installation CD or are included on a separate installation CD
with the hand control device. More information about these
devices is in the section
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Hand Control Microphones.

Philips SpeechMike Classic (with thumb slide switch)
Philips SpeechMike Pro USB (with mouse trackball)
Philips SpeechMike Classic Plus 5272
Philips SpeechMike Pro Plus 5276
Philips SpeechMike Classic Plus Barcode 5282

Philips Digital Pocket Memo 9400i (portable recorder and hand
control combo)
Philips Digital Pocket Memo 9450vc (portable recorder and
hand control combo)
Philips Digital Pocket Memo 9600/9610 (portable recorder and
hand control combo)

Olympus DR-1000 (with mouse trackball and push buttons to
record/review/play)
Olympus DR-2000 (with thumb slide switch)

Olympus DS-4000 (portable recorder and hand control combo;
requires Olympus software installation and additional
Quikscribe program QSDS4000.exe, included on Quikscribe
installation CD).

Infinity USB Foot Switch (does NOT require installation of
drivers)

VIS (Voice Input Station) USB (does NOT require installation of
drivers)

Configure Windows Audio Settings

 Close all Windows applications
 Insert the Quikscribe installation CD in the appropriate CD-ROM drive.

If the CD does not auto-start within 10 seconds, double click on My
Computer on the desktop, and then double click the CD or Removable
Storage Icon.

 Click Install. Then click Quikscribe Recorder. Next select the appropriate
hand control option. Finally, click “How to Configure Audio Settings”.
This recording will guide you in configuring your Windows audio settings.
Or, if you prefer you can follow the written directions below.

Following is a summary of the instructions given in the recording
“How to Configure Audio Settings”, which is on the installation CD
as described directly above this line.

 Click on Start on your computer.
 Select Control Panel.
 Click on Sounds and Audio Devices. (If you don’t see this option, click

on “Switch to Classic View” in the upper left of the control panel screen.)
 Select the Audio tab.
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 From the drop-down box for Sound Recording select your Quikscribe
microphone.

 From the drop-down box for Sound Playback select either (1) your
computer sound card so sound will playback through your speakers, or (2)
your Quikscribe microphone if you want sound to playback through your
microphone.

 Check Use only default devices at the left bottom of the Audio screen.
 You may now exit Control Panel.
 Now open Quikscribe Recorder.

 Select File and then Play/Record Levels.
 Select Options on this screen and then Properties.
 Select your Quikscribe microphone from the drop-down box for

Mixer Device. Select Recording. Click on OK.
 Adjust the volume upwards to the 1st or 2nd mark from the top.

Exit this screen. This level of sound will ensure that you have
good sound level input and that the typist has strong sound
level output.
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Create Shared Folders on Network Drive

Skip the section if you are not on a network or will be sending files
by email.

The Quikscribe Recorder can send files across a network. Before this can
happen, shared folders need to be properly set-up and configured.

Note: We recommend that a Network Administrator or IT support
person complete the following steps because all networks are
different and there may be issues regarding security and
permissions.

To set up your environment to send files over the network:

 Use My Computer in Windows to make a folder (directory) within a public
shared folder on your File Server that everyone in your organization may
access. Call this folder “QSFiles”. That is, create a shared folder called
QSFiles on a network drive (such as F:\QSFiles)

 Create a subfolder called f:\QSFiles\Typists.
 Create subfolders named for each typist: (f:\QSFiles\Typists\Jane;

f:\QSFiles\Typists\Joe, f:\QSFiles\Typists\Sally; etc.)
 Within each of these individually named folders, create another folder and

name it “Completed”.
 Once completed your file structure should look like this.

The above steps set up the Primary SEND destination location and associated
sub-folders to be used by the Quikscribe Record authors.

Add or Delete Typists
If at any stage you want to Add or Delete typists within the QSFiles directory, just
Add or Remove them anytime. Add or remove typists through “My Computer”,
not through Quikscribe. The Quikscribe Recorder simply builds a list based on
available typists within this directory.

If you have a large office or organization and you would like to set up multiple
typing directories, set them up by repeating the above process. You would add
another subfolder under QSFiles, such as f:\QSFiles\Typists2,
f:\QSFiles\Estates, f:\QSFiles\Dr_Doe, or f:\QSFiles\Division2. Then create
subfolders named for each typist and within each typist folder a file named
“Completed”. You set up the same structure for these new subfolders under
QSFiles as you did above for the folder Typists. The typist subfolders may be
the same names or different names.
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Once you go through this process, you’ll understand that it’s very easy to add
new destinations. For large installations, please contact Digital Technology for
special instructions to assist with installation.
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Configuring Quikscribe to Send Files

You should configure the Quikscribe Recorder before you send any audio files.

Setting Up to Send Audio Files via the Network

Quikscribe Recorder can send files across a network to your typist, who will be
notified to transcribe the files. To initialize this process, shared folders need to
be properly set-up and configured. You and your typist(s) will access these
folders. See section Create shared folders on network drive above, which
describes setup of your Primary SEND destination location and associated sub-
folders.

Note: We recommend that a Network Administrator or IT
support person create the folders because all networks are
different and there may be issues regarding security and
permissions.

In the QS Recorder, you specify the send destinations in the "Send
to" panel. That is, you create a dictation file, and then select Send. In the
"Send to" panel you can then enter the destination folders for the initial setup.
Follow the instructions Add Send path destinations for networks below to
configure your recorder to send files. (Demonstrations are shown in the video
tutorials.)

You may also set up destinations using email addresses. See below for e-mail
destinations.

Add Send Path Destinations for Networks

Perform for each QS Recorder!

 Open the Quikscribe Recorder software.
 Click on the Send Audio File icon.
 Under the “Method Tab” select Network.
 Next, select Edit Path.
 Using the “Network Locations” dialogue box, navigate your way to the

public shared folder on your File Server.
 Select and double-click the QS Files\Typists folder that was created in

the section Create shared folders on network drive above.
 Then select Add. Typists will now appear under Current Sites as shown

below.
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 Click OK.
 Then select Add and then OK.
 You will see within the Typist list box, a list of all typists in the

QSFiles\Typists directory. Below is an example of how your “Send to”
panel will look.

 Click Close.

Setting Up to Send Audio Files via E-mail

The Quikscribe Recorder can easily send files across the Internet via e-mail.
Before you can do this, Quikscribe needs to be configured to send files by e-
mail. Following are the steps for e-mail configuration.

 Open the Quikscribe Recorder software.
 Click on the Send Audio File icon.
 Under the “Method Tab”, select E-mail.
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 Click on Edit Path.
 Enter the e-mail address you would like to add.
 Then select Add and then OK.
 Click Close.
 Click on the File Menu.
 Click on Recorder Settings icon.
 Go to Author’s Details. Enter your Email address.
 Check either Use SMTP Server or your default email client. In the

example below the default email client is Microsoft Outlook. See these
options in the image below.

 If your Internet Service Provider requires your name and password, select
SMTP Settings as shown in the image above. A panel for SMTP
Settings will display as shown in the image below. Enter the Username
and password that you use for your email. If your Internet Service
Provider requires user authentication, check the box Server requires
name and password. Click OK.

 Now click OK in the Author’s Details panel.
 Click on System Settings again.
 Go to Record Controls Tab. Before sending an audio file via e-mail it is

highly recommended that the file be compressed; otherwise it may take
ten times longer to send the audio file. For Record Compression, select
either “Real Time Compression” or “Post Compression”.

 Then click OK.

Registration and License Management

A single license key is used for all installed copies of QS Recorder and QS
Player in your office. You do not need individual license keys for each copy of
the software. You will have one license number for QSR and one for QSP.
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Please register your software within 30 days of installation; otherwise it will go
into DEMO mode. If the software goes into DEMO Mode, you will only be able to
record for up to 30 seconds.

If you are using Windows 2000, XP or Vista, make sure you are logged in with
Administrator rights; otherwise you may encounter problems with the
registration process below. To check if you have Administrator rights, click Start
 Control Panel User Accounts on your computer. Your account will
display computer administrator below it if you have Administrator rights.

Registration

To register Quikscribe Recorder do the following within either the Quikscribe
Recorder.

 Select the Help menu.
 Select the Register option.
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 Locate the registration code (with dashes) provided upon purchase for
the Quikscribe Recorder or Player.

 Copy (CTRL-C) and Paste (CTRL-V) this registration code into the space
provided or type the code into the entry panel. The code is not case
sensitive.

 IMPORTANT: Type the user id or PC identification in the User ID panel,
and then select Register. Please enter a unique entry to identify the PC
– this will be helpful for any future support issues such as license transfer
to another PC.
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Select Register to confirm the entries:

The following panel will appear confirming the registration for the PC.
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At this stage your software should be registered. Check the status of your
registration with these last two steps.

 Within Quikscribe select the Help menu.
 Select the menu option 'License Info'. Your license level should be “Full

Quikscribe Recorder License”.

The same QSR or QSP registration code is used for all PCs purchased under
your account, according to the number of licenses purchased.

Deregister and Move License to another Computer

The registration method allows you to easily transfer a license from one PC to
another. You may Deregister the software and move the license to another
computer using the same registration code (without intervention from Digital
Technology).

To deregister, do the following within Quikscribe Recorder.

 Select the Help menu.
 Select the License Info option.
 Click the button Go Online.
 Print or copy your license number so you can paste it to or enter it in

another computer.
 Click the button Deregister.
 Once more … Click the button Deregister
 When you next open Quikscribe Recorder on this computer, demo mode

will be operational which will allow only 30 second dictations.

Your license number is now removed from the computer from which you
deregistered Quikscribe Recorder. You may now install Quikscribe Recorder on
another computer. Follow the registration instructions above to register
Quikscribe Recorder on the other computer.
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Hand Control Microphones

Hand Control Microphones are an integral part of Quikscribe. Choosing the
right microphone for your business and becoming familiar with it are very
important. If you generally dictate at your desk, a USB (non-portable)
microphone may be best for you. If you often dictate away from your desk, a
portable microphone may be a better choice. Base your choice of microphone
on your style, type, and location of work.

Common Hand Control Microphones

Below are the pictures of some common hand control microphones.

Philips Speech Mikes

Voice Input Station Olympus Hand Control Microphones
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Olympus DS-4000 Philips DPM 9400/9450

Philips Digital Pocket Memo 9600

Hand Control Training

To review or define specific button functions for the Hand Control microphone,
click on Help and then select Hand Control Training. (See below for using the
USB foot switch for recording.) Quikscribe will display a picture of your hand
control microphone. By pressing each button on your hand control, the onscreen
picture will display the function of the button.
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Hand Control Training displays a graphic image of the device you have
connected to the PC. The Quikscribe Recorder automatically recognizes the
device, and shows and tells you the functions of the buttons on the hand control.

Press each button on the hand control, or use your mouse to select the button.
The function of the button will then display and play. Through the tutorial, you
may change the function of programmable buttons according to your personal
preferences.

A drop-down box will display at the top of the function panel for buttons that are
programmable. By clicking on the drop-down box, a list will appear showing all
the available options for assigning the desired function to a programmable
button. An explanation of each function is displayed when it is selected.
Additional options may be displayed at the bottom of the panel, if they apply to
the selected function.

The functions of a portable microphone may vary depending on whether the
microphone is connected or not connected to the USB port of your computer.
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Below is a list of programmable (optional) functions.

Hand Control Programmable (Optional) Buttons

Following are the functions that may be assigned to any of the programmable
buttons on the hand control. Some functions have additional features which are
listed below the description of the function.

Beginning of File – move pointer to beginning
Close File – close audio file
Display File Menu – displays file menu
Display Marker Menu – displays marker menu. Please see the section

Markers Menu for information about using markers.
End of File – move pointer to end of file
FforwardAudio – fast forward the audio

Insert Blank Marker
Insert Marker & Add Attachment
Insert Marker & Capture Active or Full Screen

Insert Marker & Capture Active Window
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Insert Marker & Capture Defined Screen Region: allows you to specify a
region of the screen and capture the image as a marker in the IAF. This
is a convenient tool to use for including visual examples with an audio
explanation.

The default is:

If you uncheck this option then you can define the capture region.

Click the button Change Capture Region. The following panel will
display to allow you to define the capture region. You may
now enter the X, Y mouse coordinates and the width and
length of the capture region.

Insert Marker & Capture Full Screen
Insert Marker & Paste Clipboard
Insert Marker & Paste Image
Insert Marker & Paste Plain Text
Insert Marker & Paste Rich Text

Last Record Edit – move the pointer to the position of the start of the last
recording edit
New File – create new file

Nil Function – deactivate button on hand control
Play Audio - Plays audio. The default is the checkbox “Hold down to

play” is unchecked, which allows you to press the button to play
audio and to press it again to stop playback. If you check the box
Hold down to play, audio is played when the button is held down
and stops when the button is released.

Using markers in Quikscribe is a unique, powerful
feature to include text, images, or other files within

the audio dictation and workflow.
Please see the Markers section for a complete

explanation.
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Record Audio

Recording Mode – toggle between insert, overwrite, and append modes
Redo Audio – see description of Undo/Redo in the section Undo

Dictation and Redo Dictation .
Rewind Audio

Send File

Undo Audio - see description of Undo/Redo in the section Undo

Dictation and Redo Dictation

Hands-Free Recording Using Foot Switch

The USB Foot Switch provides a hands-free recording capability (which is ideal
for pathologists or other professionals that need to use both hands for other
activities). Rather than using a Hand Control Microphone, you can use the triple
action foot switch in conjunction with a boom microphone or a
Headset/Microphone. As a result, you can Record, Stop, Rewind and Play while
doing other things with your hands.

Below is how the foot switch works.
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NEW
FILE
RECORD
PLAY
REWIND
SEND

If no file is currently open, press button No 2
Hold button No 2 down to Record, release to stop
Hold button No 3 down to Play, release to stop
Hold button No 1 down to Rewind, release to stop
Hold button No 1 down then hold down button No 3 (not visa versa)
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Set Automatic File Naming

To save time, the Quikscribe Recorder can automatically name each new audio
file created and at the same time, index the file number by one, to ensure that
each new file created is unique. To enable this feature of Quikscribe follow the
steps listed below. (If you prefer to name each file as you record it, please skip
these steps.)

 Open Quikscribe Recorder. Select File System Settings File
Management.

 Enter your name or initials for User Name.
 Check Enable Auto-Numbering.
 Check Auto-Number Imported Files.
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Using the Quikscribe Recorder

Main Interface
Open Quikscribe Recorder. You will see the main interface as shown below.

Here is the main interface as it appears when recording. The function of each
toolbar icon is labeled and the bar at the bottom of the screen shows the status
of the recording. The file name of the current recording is shown in the top bar
of the screen. Please review the interface. The user interface has been
designed to be relatively simple to use and understand.

Ne
w Open

Undo

Redo

Close

Send

Settings

Audio Level

View Markers

Slider Bar

Attachments

State

Mode

Position

Length

File Name

Play Controls
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For the detailed function of the icons see the section The User Interface –
Detailed Description.

Record and Send an Audio File

You are now ready to record an audio file.

 Click the Create New Audio File Icon. *
 Enter any file details that you wish to add e.g. Subject, Matter No, etc.
 Click Create or press ‘Alt R’ on your keyboard. This will create your

new audio file. Click Cancel or press ‘AltC’ to CANCEL the creation of
the file.

 Slide to REC or hold down the REC button on the Quikscribe Hand
Control and speak to record. The microphone is built into the Hand
Control. To stop recording slide to STOP or release the REC button.

 Slide to F.RWD or press F.RWD to return to the beginning of the dictation.
 Slide to PLAY or press the PLAY button to hear what you have just

recorded. (If you cannot hear the recording, please refer to the video
demonstration on the installation CD, “How to Configure Windows Audio
Settings”.)

* You may program a button on your hand control microphone to perform this
function.

Now you are ready to send your audio file.

Provided you have set-up Quikscribe correctly, it is very easy to send audio files.
If you encounter problems sending the file, please refer to the section above
“Configuring Quikscribe to Send Files.”

To send an audio file across the network:

 Click the Send Audio File Icon. *
 Under the “Method Tab” make sure Network is selected.
 Select the typist who will transcribe your dictation from the list of Typists.
 Select the “Required In” time and “On Completion” notification.
 Click Send.

* You may program a button on your hand control microphone to perform this
function.

To send an audio file by e-mail:

 Click the Send Audio File Icon. *
 Under the “Method Tab” make sure E-mail is selected.
 Select an e-mail address from the list box.
 Select the “Required In” time and “On Completion” notification.
 Click Send.
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* You may program a button on your hand control microphone to perform this
function.

When the file is sent for transcription, the date and time the file is due to be
completed is added to the filename as a prefix.

Features of the Interface

The user interface title bar shows the current filename open. To access the top
menu functions you can click on menu item or press the ‘Alt’ key then the
desired menu item. For ‘File’ press AltF.

Status of the Recorder

The status of Quikscribe Recorder is quickly determined by looking at the status
indicator in the top left corner of the user interface. Below are some examples of
the indicator.

The indicator flashes alternately white, then red while recording.

The letter I in the top indicates Insert mode; O indicates overwrite
mode, A indicates Append mode.

The possibilities of the indicator are:

 Microphone – no file open
 O – file is open in Overwrite mode (recording will overwrite existing

content)
 I – file is open in Insert mode (recording will be inserted between existing

content)
 A – file is open in Append mode (recording will always be appended to

the end of the audio file, no matter where the starting position for
recording is located)

 P – file is playing
 Backwards arrow – file is rewinding
 Forwards arrow – file is moving forward
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The taskbar icon also flashes alternately red and white while recording.

In addition, the Status Bar shows the current status of the file.

From left to right the status bar displays:

 Number of attachments
 Current recorder status
 Recorder edit mode – Insert, Overwrite, or Append
 Current file position – hours: minutes: seconds
 File length – hours: minutes: seconds

Slider Bar, Play Controls, and Volume Indicator

The slider bar and play controls allow you to control your position in the file, and
the current action of the Recorder.

The slider may be moved using the mouse from the beginning of the file to the
end of the file and to any position in-between. The action of the play controls
from left to right is:

 Beginning of file
 Rewind File
 Play File
 Stop File
 Record
 Forward File

Status Bar

Slider Bar

Play Controls
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 End of File

The Volume Indicator shows you the record and playback audio levels.

Insert Dictation

Now you are ready to change an audio file by inserting dictation.

The Quikscribe Recorder normally records in OVERWRITE mode, like a
traditional tape cassette recorder does. However, the Quikscribe Recorder can
also record in INSERT mode, which means you can insert additional dictation
within your existing recording (e.g. mid-sentence) rather than having to add
dictation at the end of your recording. Append Mode ensures that recording
content is not lost. If you rewind and review the existing recording, then select
‘Record’, the position pointer will move to the end of the existing file and
commence recording at that point. If the same thing were done in ‘Overwrite’
mode, as with a tape system, existing content would be overwritten. You may
also define the default recording mode to be used every time a new file is
created.

There are three ways to change the Recording mode from OVERWRITE mode
to INSERT mode.

 Use the INSERT button on the Hand Control (providing it is configured do
so under the Record Tab under the Settings Icon).

 Press the “Insert” key on your keyboard, which will toggle the record
mode from Overwrite Mode to Insert Mode and visa versa.

 Select the Edit menu and then select Insert or Overwrite Mode.

When you change the Recording Mode from OVERWRITE mode to INSERT
mode, the status bar at the bottom of the Quikscribe Recorder will update and
display which mode you are in. In addition, the indicator in the top left corner will
show “O” for OVERWRITE or I for INSERT.

To demonstrate inserting dictation, do the following:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record “A - B - C - D - E” in Overwrite Mode.
 Rewind to the beginning of the audio file.
 Change the Record Mode to INSERT mode by using one of the three

ways above.
 Record “1 - 2 - 3 - 4 - 5”.
 Rewind to the beginning of the audio file and press or click PLAY.
 You should hear “1 - 2 - 3 - 4 - 5 - A - B - C - D - E”.
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The markers
are shown
here.

Detail Panel – File Information and Markers

The Quikscribe Recorder user interface shown below displays the Detail Panel.
In detail view the information entered when a file is created is displayed. In
addition, markers for text or images that are to be imported and included with
your dictation are displayed.

The Detail Panel shows you the important
metadata associated with the file. (The
details are grey and cannot be edited).

The Markers Panel shows current
markers inserted in the file. Double-click
the marker number to display the Marker
Settings panel to review and edit as
desired.

To toggle detail view
on and off press the
arrowhead.
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Insert Marker in Recording

Quikscribe can insert referenced material such as text, images, graphics,
Internet links, screen captures, etc. directly into the dictated file. The insertions
are made available to the typist and eliminate the need for the insertions to be
retyped or reconstructed. To do so the Quikscribe Recorder creates and inserts
marker files. As described above, Markers are listed in the detail panel.

The main advantage of marker insertions is to save time. Rather than dictate text
from other documents or web sites or rather than direct the typist with sources
for text, the text can be copied and pasted.

To demonstrate:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record “A B C D E”.
 Open an existing Text or Word document and select some text within the

document with your mouse or with keyboard keys.
 Press CTRL C.
 Now press CTRL 7. This is the default Hotkey for the Quikscribe

Recorder to paste a marker. As a result, a Marker File containing the
contents of the text you selected will be created within your audio file.

 View the Markers panel to see the Marker that has been added.
 Click the Marker to select it. To view the Marker, double-click it or select

Markers from the top menu and select View Selected Marker.

Attach other Files or Documents
The Quikscribe Recorder can attach other files and documents within the audio
file. These files can then be extracted by the Quikscribe Player.

To demonstrate:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record some audio and then stop.
 From the menu bar select File and then Add Attachment.
 Using the Add Attachment dialogue box, browse your Hard Drive or

Network, select a sample file, and select Open.

At this stage, the file you selected is attached to your current audio file. In the
bottom left hand corner of the Status Bar you should notice #1, signifying that
you have one attachment to the file.

If you want to Remove or Extract any attachments from an audio file, do the
following:

 From the menu bar, select File and then View Attachment.
 Select the file you want to Remove or Extract.
 Then select either Remove or Extract.
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The User Interface – Detailed Description

The User Interface of the Quikscribe Recorder provides interaction with the
software controls using the PC display monitor and computer mouse. For
normal dictation, it is not necessary to rely on the User Interface display, as the
hand control microphone (such as Philips SpeechMike or Voice Input Station)
will provide all controls for recording/playback, as well as advanced features
available on the special function buttons (see section
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Hand Control Microphones).

New Audio File

Selecting this icon -- -- will create a new audio file so that you can begin
recording. Below is an image of the panel that will display when you select the
new audio files icon. You may enter subject, Doc Name, matter No., and Doc
Type. You may select the Intelligent Audio File (.iaf) format. The file will be
named automatically if you selected Enable Auto-Numbering in Settings.
Otherwise, you will enter the file name. You may override the file name even if
you have automatic numbering set.

You may also assign the New File function to a button on your hand control. To
assign the new file function to a button on your hand control:

 Choose Help, then Hand Control Training.
 Press the button on the hand control that you wish to assign the new file

function.
 From the drop-down box choose New File.
 Press Close.

Three options are available for creating new files:

 The 1st option creates a new file and brings up the ‘New Audio File’ box
which allows you to add information, such as subject and matter no., to
the file. To choose this option go to the Recorder Setting icon and
choose the File Management Tab, check ‘Allow data to be entered’,
and click OK. After you send a file, you will need to click the new file icon
to create a new file.



39

 The 2nd option automatically creates a new file but will not display the
‘New Audio File’ box. To choose this option go to the Recorder Setting
icon and choose the File Management Tab, check ‘Just create a new
audio file’, and click OK. Now after you send a file, Quikscribe will
automatically create a new file. With this option the ‘New Audio File’ box
is not available to add information, such as subject and matter no., to the
file.

 The 3rd option automatically creates a new file and displays the ‘New
Audio File’ box. To choose this option select Help, then Hand Control
Training. Press the send file button, then check Send current file then
automatically create a new file, and click close. This option
automatically creates a new file when you send the current file and brings
up the ‘New Audio File’ box which allows you to add information, such as
subject and matter no., to the file.

To save time Quikscribe automatically names the new audio file based on the
“Sender User Name” which is set under the File Management Tab under the
Settings Icon. However, if you want to change the file name, you can do so
before pressing Create.

Open Audio File

The Open Audio File icon allows you to open existing files that are in your draft
or sent directory. Selecting this icon displays the Open Audio dialogue box,
where you may open files from the Draft Files folder or from the Sent Files
folder. Alternatively you can select the Browse button and open any .iaf file on
your system.

You may open a file by double-clicking the file name or by pointing to the file
name and then clicking Open.

By clicking Draft audio directory or Sent audio directory at the bottom left of
the screen, you may quickly view the files in the Draft or Sent folders. The Draft
folder contains all work that has not been to transcription, and the Sent folder
contains all files that have been dictated and sent. The files will remain in the
Sent folder as a backup for the default time period of 14 days. You may change
this to a longer period in System Settings.

An image of the Draft audio directory appears below. As you click on a file
shown in the Draft audio directory, the File Details will appear for the file, and
you will hear an audio preview to help identify the file to open. You may enter
and modify the contents of the following File Details fields: Subject, Matter No,
Doc Type, and Doc Name. Just type your additions or changes to each field,
and then press the Enter key to complete and save your changes. Press the
Tab key to move from one file detail to another; however, the Enter key must be
pressed after adding or modifying a file detail. While you are editing, the text will
appear in blue, and upon completion the text will appear in black.
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Now select the Sent audio directory. See an image of the Sent directory
below. Click on each file in the sent directory. In addition to the file details
displayed for a draft file the following details are included: the date and time
sent, the typist destination, the sent filename, and the status. In addition, recall
and status options are available. If you wish to cancel dictation of a file, click
Recall. If you wish to know more details regarding the status of the transcription
and typist, press ? .
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You may also sort the files in either directory by date by checking Date order.

The Master audio directory contains master templates for files created in
Presentation or Education mode (instead of Dictation mode). See the section
Intelligent Audio File Format for descriptions of the various recording modes.

The Draft folder contains all work that has not been to transcription, and the Sent
folder contains all files that have been dictated and sent. The files will remain in
the Sent folder as a backup for the default time period of 14 days. You may
change this to a longer period in System Settings.

As you click on a file shown in the Draft or Sent audio folder, the File Details
will appear for each file, and you will hear an audio preview to help identify the
file to open. File details such as the date and time created and sent, the typist
destination, the duration of the file, and the status are displayed for files. If the
little yellow speaker to the left of the Refresh button is enabled, you can listen
to the audio file before opening it. To disable this function, simply click on the
little yellow speaker to mute the sound.

You may delete a file by pointing to the file name and then clicking Delete. If
you delete a file in Quikscribe Recorder, a copy of the deleted file is placed in the
Windows Recycle Bin, allowing later recovery if necessary. You will receive the
following prompt when you choose to delete a file.
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If you attempt to open a file in the sent directory, you will be prompted regarding
opening the file. In addition, recall and status prompts display.

Recall

If you wish to cancel dictation of a file that you just sent or add dictation to the
file, click Recall. The file will be removed from the typist queue and added back
to your draft directory.

If a file cannot be recalled, you will receive the prompt warning you that the file
cannot be recalled.

Table View

You also have the option of a Table View of file in the Draft and Sent folders.
Click View at the top left corner of the Open Audio File to toggle between
Normal and Table views. The image below shows Table view and the image at
the top of this section shows Normal view. Clicking on a column heading will
sort the table by the column heading. For example, by clicking Date and Time
Sent the table will sort by that field.

By selecting Draft files, Sent files, or All Files from the pull down box at the
bottom left of the screen, you can quickly view the files in the Draft or Sent
folders. You may also select All Files from the pull-down box to view both draft
and sent files. Alternatively, you can select the Browse button and open any .iaf
file on your system. Clicking the Comments / History button will display a
history of the time spent by the typist(s) working on the file.

You may open a file by double-clicking the file name or by pointing to the file
name and then clicking Open. Use the down arrow to move among files in
the table.
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Undo Dictation and Redo Dictation
The Undo Dictation and Redo Dictation icons are designed to SAVE TIME. This
feature is useful if your dictation recording style utilizes frequent starts and stops.
That is, for each time you press the Record button, and then stop recording,
Quikscribe considers this passage as an “audio edit”. You may UNDO each
audio edit, as Quikscribe recognizes the section from the last “stop recording” to
the previous “start recording”. Never again will you have to waste time rewinding
and finding your position within an audio file to overwrite a mistake. Simply
press Undo and start recording again.

With the Quikscribe Recorder, you can instantly remove any mistakes when
dictating by simply pressing the UNDO button (eliminates the need to rewind and
find the position to re-record over a mistake). The REDO button provides the
opposite function and recalls previously recorded sections. So if you made a
mistake and pressed UNDO to wipe it, but then changed your mind, you could
instantly recall the ‘wiped out’ passage by pressing REDO.

To practice undo and redo, do the following:

 Create a New Audio File.
 RECORD “One” then STOP.
 RECORD “Two” then STOP.
 RECORD “Three” then STOP.
 RECORD “Four” then STOP.
 RECORD “Five” then STOP.
 Now press the UNDO button on the Hand Control twice.
 Now REWIND to the beginning of the audio file and press PLAY.
 You should hear “One - Two - Three”.
 Now press the REDO button twice and then press PLAY.
 You should hear “Four - Five”.
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You may assign the Undo and Redo functions to buttons on the Hand Control,
allowing you to quickly record and edit in real time. As a result, dictation has
never been easier. Use the Hand Control Training to program the Undo function
to the desired button on your hand control microphone. (Go to Help, then Hand
Control Training).

Close Audio File

The Close Audio File icon allows you to close the current audio file. When you
select the Close Audio File icon, Quikscribe automatically saves all the material
within your audio file, i.e. current Markers, Text Attachments, Screen Shots and
your file position. Your file is saved in the Drafts folder and will be available for
you to open by pressing the Open Audio File icon.

Quikscribe does not have a SAVE button, because Quikscribe continually saves
your file. This means that every time you record or make an edit, Quikscribe
automatically saves. If power is lost to your PC at any time, you will not lose
anything. Just open the file from your Draft folder the next time you start
Quikscribe Recorder.

Send Audio File

The Send File Icon allows you to send your audio file either by the Network,
FTP, or via E-mail. You can send either in .iaf or .wav format. You may choose
either format in the File Management Tab under the Settings Icon. You may
also select .wav format in the Send Audio File panel. Only the Quikscribe
Recorder and Quikscribe Player can open an .iaf file. If you wish to create or
send audio files to someone that does not have Quikscribe, you will want to send
a standard .wav file. A .wav file will contain only audio; attachments will not be
included as in an .iaf file.

When you press the Send File Icon, a ‘Send To’ dialogue box will appear. Here
you can select the method (Network, FTP, or E-mail) and recipient. The ‘Send
To’ panel provides the mechanism to enter the destination identification for any
and all of the ‘file send’ methods of Network, FTP, and Email. Edit Path allows
you to define the destination for each method.

For example, if you are sending files to a shared folder on your network file
server and wish to add a path to send files do the following:

 Click the Send Audio File icon.
 Select the Network method.
 Click Edit Path.
 Double-click the destination folder under Site Location that you wish to

add.
 Click Add to include the destination under Current Sites.
 Click OK.
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 The new destination folder will now be shown in the top box of the Send
to dialogue box and the names of the typists will appear in the bottom
box.

The destination you added will appear in the Network as the directory
Typists does below. The subfolders, which will generally be the names of
the transcriptionists, will display in the box with the heading Typist. When
you send a file to a typist, the typist name appears at the top of the
dialogue box. In the box below the dictation is being sent to Sally, so the
top of the box shows: Send to C:\QsFiles\Typists\Sally. When you
send a file you may choose from the destination folders in the top box and
from the typists in the bottom box.

Note: To send files through a network, shared folders need to be properly
set-up and configured. You and your typist(s) will access these folders.
See the section Create Shared Folders on Network Drive, which
describes setup of your Primary SEND destination location and
associated sub-folders. To add Typists’ names in the Typists section in
the Send To box, please refer to the instructions listed under the section
Add or Delete Typists.

If you are sending files to an FTP site, select FTP as the method, then select
Edit Path to enter the logon parameters for the FTP site. FTP Target Directories
Are Set Intuitively. You can easily browse to define the exact folder on the FTP
file server.
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If you are sending files to an email address and wish to add an email address,
do the following:

 Click the Send Audio File icon.
 Select the E-mail method.
 Click Edit Path.
 Type the New e-mail address that you wish to add.
 Click OK.
 The e-mail address will now be shown in the box under E-mail of the

Send to dialogue box.

The e-mail address you added will be shown in the box under e-mail as the e-
mail addresses show below. When you send a file to an email address, the
address appears at the top of the dialogue box. In the box below the dictation is
being sent to Jack, so the top of the box shows: Send to
jack@quikscribe.com. When you send a file you may choose from the e-mail
addresses displayed.

Send as wave provides the option to send the recorded audio file in universal
.wav format instead of .iaf (Intelligent Audio File) format. The advantage with
this feature is to be able to send an audio file (or audio email message) to an
outside recipient who does not have the Quikscribe software installed.
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Note: To send a file through email your email address must be entered in
Author’s Detail in system settings. In addition, compression of the file is
recommended.

If you have a single typist that you send all your dictation to and you do not wish
to provide additional instructions before sending your audio file for transcription,
you can speed up the process by eliminating the ‘Send To’ dialogue box. To
disable the dialogue box click on the Recorder Settings Icon, select File
Management tab and then select the option ‘Just send the current audio file’
from the Send Audio Icon option.

When you send a file, you can also include the following instructions:

 Turn around time (priority)
 Notification required (e-mail or phone) upon completion
 Request for a print out of your document
 “Archive audio” tags so the audio portion of the file is saved in the Archive

folder as a .wav file for future reference
 Additional Comments / Keywords

See below for further description of these instructions.
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The instructions for the date and time when a completed document is due may
be selected from the Required In feature in the Send to panel. The options are:

Urgent 3 hrs
Today (by 5 P.M.) 4 hrs
Tomorrow (by 5 P.M.) 5 hrs
15 min 6 hrs
30 min 7 hrs
45 min 8 hrs
1 hr 12 hrs
2 hrs 24 hrs
3 hrs 48 hrs

(Note: the default settings may be saved by clicking the icon).

The instructions for notification On Completion of the document prepared from
the dictation include the following options:

 No Notification
 Call Author – The typist is prompted to call the author upon completion of

the document.
 Call Secretary – The typist is prompted to call the author’s secretary

upon completion of the document.
 Email Author – Quikscribe Player prepares an email to send to the

author and the typist is prompted to attach or link the document upon
completion of the document. For this option the author’s email address
must be entered in Settings>Author’s Details.

 Email Secretary – Quikscribe Recorder sends an email to the author’s
secretary to expect transcription notification when the author sends the
dictation for transcription. Quikscribe Player prepares an email to send to
the author’s secretary and the typist is prompted to attach or link the
document upon completion of the document. For this option the author
and secretary’s email addresses must be entered in Settings>Author’s
Details.

“Send To” Dialog Box

Required in: Select turnaround time from
dropdown box. ‘Urgent’ is at top of list.

On completion: Request phone or email
confirmation upon completion, including return
document via email.

Print out: Request for your document to be printed.
Archive audio: Store .wav file copy of audio file.
Comments/Keywords: include additional notes or

instructions.
Send as Wave: Send as .wav file instead of .iaf file.
Encrypt: Encrypt file for security. See Options
below.
File Details: add or modify the Subject, Matter No,
Doc Type etc.
Options: Split file and/or add password. See below.
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Quikscribe Recorder provides Options to split the audio file into smaller
segments. This is most useful when using the Email method, in order to get past
the file attachment size limitations of many Internet Service Providers. To use
this feature with email do the following:

 Click Options in the Send to dialogue box. The box that appears is
displayed below.

 Select “When sent via E-mail”.
 Select the desired time increment under Split Audio Method. 15 minutes

should be appropriate for most dictation.
 Enter an automatic Audio Overlap time of 5 seconds or more to assist

with collating the audio files during transcription. The overlap will repeat
the end of the previous split audio file.

 Generally Express Send will be unchecked. Express Send will send the
file without placing a backup copy in the Sent folder and is NOT
RECOMMENDED to use. This feature exists at the request of some
users who prefer speed to insurance of the backup copy.

 Click Save.

To enable encryption:
 Click the Set Key button in the Send Audio Options box. The Set

Encryption Passphrase box appears. See the box below.
 Enter and confirm a Passphrase (or password) that will be used by both

the QS Recorder and QS Player. The passphrase should be the same on
all copies of the QS Recorder and QS Player for the entire organization.

 Click OK.
 Click Save on the Send Audio Options box.
 Now create a test file and send it with encryption enabled.
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 You will now have the option to encrypt a file when you send it by
checking Encrypt in the Send to dialogue box. The test file you created
and sent will not be encrypted but future files sent may be encrypted by
checking Encrypt in the Send to box.
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Settings Icon

The Recorder Settings icon allows you to configure the Quikscribe Recorder.
When you click on the Settings icon you will see five tabs:

 Record Controls
 File Management
 Author’s Details
 Voice Recognition
 Hot Keys

You may also access the recorder settings by choosing File and then System
Settings.

Hand Control Training

The button for Hand Control Training is available at the bottom left of each tab.
If s

Factory Reset

The button for Factory Reset is available at the bottom left of each tab. This
button enables settings to be completely reset. If factory reset is selected, paths
will need to be reset and file storage locations may change. Other settings will
also be lost. This button should, therefore, be used with caution.

Information about the settings within each tab follows.
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Record Controls

The Record Controls tab lets you set the recording mode and features for the
Quikscribe Recorder.

Record Quality
Record Quality sets the sample rate required for recording. The Quikscribe
Recorder can record at five different sample rates: 4 kHz, 8 kHz, 11 kHz, 22
kHz, and 44 kHz. A high sample rate produces better audio quality but a larger
audio file. A low sample rate produces lower audio quality but a smaller audio
file. Medium quality of 11 kHz provides good quality for most recording and
produces a moderate sized audio file.

If recording files are sent over the Internet, record quality of 8 kHz or 11 kHz is
recommended to keep file size to a minimum and Real-Time Compression or
Post Compression is recommended.

Record Compression
The Quikscribe Recorder provides three options for record compression.
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Real Time Compression – As you record, Quikscribe is compressing the audio
file on the fly and saving the data to disk. This is the preferred option as the files
are much smaller and when sent for transcription, are already compressed. The
Cal button next to the compression drop-down box will calibrate the sound card
for real time compression. Calibration is necessary only if a clicking noise
becomes evident when recording.

Post Compression – Quikscribe saves the file in a non-compressed format
within the .iaf file. When the file is sent for transcription, Quikscribe then
compresses the audio file.

No Compression - Quikscribe saves the file in a non-compressed format within
the .iaf file.

Real-time compression is the best mode to record in, as the resultant audio files
are very small and there is no delay when you press Send because the audio file
is already compressed. The only downside is that your PC must have the
processing power and memory resources to perform real-time compression. If
you are using an old PC, you may have problems, in which case you will need to
use Post Compression. Or if you like, you can choose no compression. The table
below illustrates the size of the uncompressed and the compressed files based
the on the sample rate or record quality.

Sample Rate Uncompressed
Compressed

4 kHz 480 kBytes/Min 49 kBytes/Min
8 kHz 960 kBytes/Min 98 kBytes/Min
11 kHz 1.32 Meg/Min 135
kBytes/Min
22 kHz 2.64 Meg/Min 270
kBytes/Min
44 kHz 5.28 Meg/Min 540
kBytes/Min

Intelligent Audio File Format
This feature sets the recording format. Dictation Mode is the default format. A
description of each mode follows.

 Dictation Mode – Used for standard dictation. This is the default
recording mode. To record, the RECORD button on the Quikscribe Hand
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Control is held down. To stop recording the RECORD button is released.
To record more audio, the RECORD button is pressed down again and
released once again to stop. When the file is sent for transcription, the
date and time the file is due to be completed is added to the filename as a
prefix. Every time the RECORD button is held down and then released to
stop, an audio edit is allowed. This means the Undo and Redo feature
may be employed to remove or replace audio dictation.

 Transcription Training Mode – This mode is identical to the above
Dictation Mode, except when the audio file is finished and sent for
transcription, an internal flag is written within the file, preventing the file
from being deleted once it is completed within the Quikscribe Player. This
allows a trainer or teacher to create training content or lessons that will
not be accidentally deleted after completed by students. No date or time is
present at the beginning of the file.

 Computer Based Training (CBT) Mode – Used for developing CBT
audio/visual presentations (see CBT development manual). From a
recording perspective, this mode is identical to the above Dictation Mode.
The major difference being when the audio is played in the Quikscribe
Player, any captured screen shots (BMP) or embedded images (PNG,
JPEG, WMF) within the audio file are visually displayed within a separate
window. This makes it is possible to record and create web-ready CBT
content seamlessly behind any windows based application.

 Presentation Mode – Used for developing audio/visual presentations
with MS-PowerPoint. This mode is very similar to the CBT above.
However, rather than displaying images within a separate Window when
played within the Quikscribe Player, images are displayed full screen.
This mode is ideal for making dramatic audio/visual presentations.
Images can accurately and easily synchronize with audio since Quikscribe
very efficiently supports graphics.

 Interview Recording Mode – Used for tamper-proof recording. A time
and date stamp is kept of the recording session. To record, the RECORD
button on the Quikscribe Hand Control is pressed once to start recording.
To stop recording, the RECORD button is pressed again. The major
difference with this recording mode and all the other recording modes is
that audio can never be edited. Overwrite, Insert, Undo or Redo audio
edits are not available in this mode. At any time the recording may be
stopped, rewound, and played. However, when the RECORD button is
pressed again, the Quikscribe Recorder automatically jumps to the end of
the audio file and appends the additional audio as a separate track within
the same file. Each time recording is started or stopped, a special
Interview Marker that cannot be deleted or modified is inserted in the
audio file, detailing the date and time when the audio started or stopped.
Also, in this mode, all new audio files are automatically named with the
current date and time. Lastly, in this mode both the Import Audio and
Export Audio feature are disabled, ensuring that the original audio file can
never be modified or changed by anyone. When the audio file is played in
Quikscribe Player, rather than displaying the percentage (%) completed in
the task bar when being transcribed, the actual time (HH:MM:SS) when
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the file was recorded is displayed. Additionally, whenever the Quikscribe
Player encounters an Interview Marker in the file, the typist is notified with
an audio prompt and the current date and time from the Interview Marker
can be instantly pasted into the current document. The audio file cannot
be altered during or after recording and is protected from setting back of
the computer system time.

Hand Control - Comm Port
The Quikscribe Recorder uses a hand control microphone to record and edit
audio files. In order for the Hand Control to work, it must be connected to a
working USB or Comm Port (Serial Port), depending on the device.

The default setting for the Hand Control is USB Auto-Detect. For example, if
you have the Philips SpeechMike or Digital Pocket Memo you should set the
Comm Port setting to USB Auto-Detect. If you wish, though, you can specify a
specific Comm Port from the drop-down box. If you do change this setting, you
will need to close the Quikscribe Recorder and open it up again in order for the
Quikscribe Recorder to re-initialize the Comm Port.

Hand Control - Seek Speed

The Seek Speed determines the Rewind and Fast Forward speed for the
Quikscribe Hand Control. This value is measured in seconds and determines
how fast the fast-forward and rewind controls move through the dictation file.
The default value is 2. The speed and may be set between 1 (slowest) and 100
(fastest).

Recording Time Available
This displays the current available recording time on your Hard Drive. The
Recording Time Available value is in HH:MM:SS. Changing either ‘Record
Quality’ (Sample Rate) or the ‘Record Compression’ settings will directly affect
the recording time available

With modern hard disk drives, space is not really an issue, so this value will
usually be 999:59:59 and it generally means that you have more time than that
available.
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Advanced Record Options

Three options are available in Advanced Record Options as you can see below.

Voice Activation
This option can only be activated when no file is open.

As the name suggests, the input sound level will control this recording.

To use voice activation and to calibrate the sound trigger level, do the following.

 Close any open audio files
 Select Voice Activation.
 Click the ‘Threshold’ button. A dialogue box will appear to calibrate the

level at which recording will be activated.
 The ‘Current Ambient Noise’ is a value that represents the background

noise picked up by the microphone. The activation level must be set
above this value otherwise the Recorder will be constantly recording.

 ‘Simulated Record State’ shows the level the recorder would normally be
recording. BUFFERING means that the software is sampling the
microphone input levels but is not recording. RECORDING means that
the level is higher than the value in the ‘Set Trigger Level’ box below it,
and input volume will be sufficient for recording dictation.

 Set Trigger Level (Peak). Talk into the microphone at the level you
would normally speak. Do not speak louder than you normally would.
Adjust the Trigger Level until the ‘Simulated Record State’ shows
‘RECORDING’ when you speak, and ‘BUFFERING’ when you are silent.

.

Threshold Settings
for Voice Activation
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Now open or create a new file. Operating the record button will now activate the
software to record, but only when the input sound level is above the trigger
threshold set in the steps above.

Note: For hand control microphones that use buttons for record/playback instead
of the slide switch, the best way to use this option is to set the record button to
‘Press the Record button and DON’T hold down while recording’. The
button can then be used to activate recording mode with the sound level
activating actual recording. If the button were in the mode ‘Press the Record
button and HOLD down while recording’, the button would have to be held
while speaking above the trigger level to activate recording.

Pre-emption
This option is only available while voice activation is disabled.

This option allows the software to record audio prior to activation by the record
button. It is for use by people who speak before they have hit the record button.
If your typist reports that the beginnings of your sentences are clipped, you
should experiment with this option. The value is in seconds and is the amount of
audio that will be recorded prior to hitting the record button.

This option is best explained by example.

 Set the value to 2.0
 Create a new file.
 Start to count and slide to record or press the record button at three while

counting through to five.
 Stop recording and rewind to the beginning
 Play the file
 You should find that the ‘1’ and ‘2’ have also been recorded.

Provide Audible Feedback
This activates a small click sound when the recording button is pressed.

This sound is ‘click.wav’ and is found in the Program
Files/Quikscribe/Quikscribe Recorder directory.

You may change the sound if you wish, but recording will not commence until the
sound has stopped, so too long an audible warning may create unwanted delays
at the start of recording.

Record Mode Options

You may set the default record mode to Overwrite, Insert, or Append. The audio
file is in the default mode unless the mode is changed during recording. The
mode will revert to the default mode upon closing and re-opening the file. The
modes are as follows:

 Overwrite – recording will overwrite existing content
 Insert – recording will be inserted between existing content
 Append – recording will always be appended to the end of the audio file,

no matter where the starting position for recording is located
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If Store Record Mode in file is checked, Quikscribe Recorder remembers the
last record mode option chosen before a file is closed. When the file is
reopened, the record mode is in the same mode as when the file was closed.

Audio Devices
You may select the Record Device or hand control that you wish to use for
recording from various devices that are installed in your computer.

In addition, you may select the Playback Device or hand control that you wish to
use for playing your recordings from various devices that are installed in your
computer.

You may choose a different device than your computer’s sound system to
playback recordings created in Quikscribe Recorder. If you choose to playback
dictation through your hand control, other audio may still be played through your
computer speakers if your Windows default is to your computer’s sound system.
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Housekeeping & Dictation Management Options

Quikscribe has options to assist with file cleanup and maintenance. Below are
the options available for file housekeeping and management.

Automatically delete files in Sent File Path older than __ days
Once dictation has been recorded and sent for transcription there is no need to
keep the audio file indefinitely on the Quikscribe Recorder because it is purely a
means to an end (i.e. to create a printed document). However rather than
automatically delete the audio file, Quikscribe stores the file for a fixed period of
time. The original file is retained for 14 days (default), in case the audio file that
was sent via the network or via e-mail is lost, misplaced or corrupted, so then
another copy can be sent.

Prompt on startup if draft audio files exist in draft audio directory

Prompt for instructions if an audio file is already open

File Management

The File Management tab lets you set various file management features.
Please see information on file storage locations below if your locations differ
from the pattern shown in the following image.

Each time you start QS Recorder, a pop-up panel will appear
providing notification that there are unfinished dictation files in
your Draft folder that still need to be sent.

If you try to create a new file, a pop-up panel will alert you
that you already have a dictation file open. You will be
prompted to select the desired option to continue. You may

- continue recording the current file
- send the current file to be transcribed
- close the current file and create a new file
- (or Cancel)
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The File Management Tab lets you set up and configure the following:

Automatic File Naming
To save time, the Quikscribe Recorder can automatically name each new audio
file created and at the same time, index the file number by one, to ensure that
each new file created is unique (e.g. BH001, BH002, etc).

 User Name: It is suggested that you use your name or initials but it is not
mandatory. For example you may choose to name the files by department
or section where you work.

 Current Auto Number: This shows you the current auto-number. You
can change this number at any time. If you set the auto-number such that
the file it will create has the same name as a file existing in your Drafts or
Sent directories, the system will automatically choose the next number
higher than that file. For example if you already had ‘John025’ in your
Drafts directory and you reset auto-number to 1, the Recorder will create
‘John001’ through to ‘John024’, then it will detect the existing ‘John025’
and so create ‘John026’ instead.
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Note: Sent files are automatically deleted after a user defined period
(See Record Controls – Housekeeping and Dictation Management
Options)

 Enable Auto Numbering: With this checkbox set, the Recorder will
automatically number each of your files incrementally. Examples of the
resultant file are: ‘John001’, ‘John002’ or ‘JFS-001’, ‘JFS-002’. The auto-
filename can be changed before it is sent. (see Icons – Sent)

 Auto-Number Imported Files: With this checkbox set, the Recorder will
automatically name and number each of your files imported from portable
digital recorders.

 Play ‘New File’ notification: If checked, the words “New File” play
when you create a new audio file.

 Play file sent: If checked, the words “File Sent” play when you send an
audio file.

New Audio Icon

The New Audio Icon supports two modes as seen below:

Allow data to be entered - If this option is selected, Quikscribe will
automatically load the New Audio File dialogue box, which allows you to add
additional data, e.g. Subject, Matter No, Doc Type etc.

Just create a new audio file - If this option is selected, Quikscribe will
automatically create a new audio file without giving you the option to add any
additional data such as Subject, Matter No, Doc Type etc. Providing you have
‘Allow instructions to be added’ selected under the ‘Send Audio’ Icon (explained
below) you can add Subject, Matter No, Doc Type etc before sending your audio
file.

IMPORTANT: If you choose ‘Just create a new audio file’, the data entry
dialogue box ‘New Audio File’ will NOT be displayed. This is significant for
business environments that do not want to capture extra information about the
dictation file, and want to minimize the steps in the dictation process. When a
new file is created, the entry box is not displayed, and the Quikscribe Recorder is
ready to record dictation immediately.

Send Audio Icon
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The Send Audio Icon supports two modes as seen below:

Allow instructions to be added - Quikscribe will load the following ‘Send To’
dialogue box.

You may then select the File Details tab to which allows you to provide
instructions with your audio file. See the image of the File Details tab below:

Just send the current audio file - Use this mode if you DO NOT want to add
additional instructions when you send an audio file and you ALWAYS send your
audio files to the same location with the same preferences. Before selecting this
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option, send one file with “Allow instructions to be added” selected. After
sending the file, change your selection to “Just send the current audio file”.
Quikscribe will now automatically send your audio files to the typist via the mode
(Network or E-mail) you just used in sending the file. If you later need to send
files to a different typist, you wound need to repeat this process.

File Storage Locations

Below are the directory paths for the Recorder. Image 1 shows the paths as
they as set up with the current version of Quikscribe Recorder if no prior
Quikscribe Recorder profile resides on the computer. Image 2 shows how the
paths were established with prior versions of Quikscribe Recorder or with a prior
version updated to the current version. When updating, the profile of a prior
version remains and Quikscribe uses the same file storage locations to maintain
continuity.

Image 1: File storage locations if current version of Quikscribe Recorder and no
prior Quikscribe Recorder profile on computer

Image 2: File storage locations if prior version of Quikscribe Recorder or current
version with prior Quikscribe Recorder profile on computer

Under most circumstances, use the default settings from the initial
installation.
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Working Directory – Location where the Recorder creates its working
subdirectories. These directories are best left on your computer’s hard disk drive
(at the default setting of ‘c:\qsfiles’) to maximize access speed and system
performance. The working directory is the default location where all .iaf files are
created and managed. Within the working directory (not shown) is a ‘Sent’
directory acting as a backup. If this directory is ever deleted or renamed,
Quikscribe will automatically create a new ‘Sent’ directory.

Note: Although you can change the QsFiles directory under the File
Management tab, it is highly recommended that it be left as a local
directory on your computer. Because writing audio data is a very time
sensitive procedure, latencies common to most networks can cause gaps
in the recorded audio file.

Profile File – Shows path and name of current profile. The default profile file is
‘recorder.pfl’, which contains all personal settings for the system settings and
also hand control settings.

Import Path – Folder where files imported from an external source will be
placed. Quikscribe will periodically scan this folder and import files into the draft
folder.

Reports Path – For every file sent, the Recorder will write a small text file
containing the metadata for the file such as Author, Date Sent, and Method Sent
etc.

In addition to the above specifications for file/folder locations, the
Quikscribe Recorder also creates and uses the following folders for
data files. These folders are contained under c:\QSFiles:

Drafts –The working directory for dictation files for storage of files in
progress. The Quikscribe Recorder creates the recording file in the
QsFiles\Drafts directory usually found at C:\QsFiles\Drafts. It constantly
writes and saves to that location, so even if your computer crashes, most
of your recorded file will be intact.

Pending - Holding folder for files that don’t send because the
network is down.

Sent – Folder containing copies of files sent to transcription.

Management Path – If the Management option was selected during
installation (“Complete” or “Custom”), then the Management Path must be
defined to enable communication of status updates between QS Recorder
and Player. The Management Path folder will hold a repository of files
with an .imf file name extension that represent files in process. The
Management Path acts as a conduit for QS Recorder and Player, and
provides the ability to access file statistics throughout the distributed
network environment.

Generally the Management Path is defined to be a subfolder under
QSFiles on the shared network drive. For example, if files are sent from
QS Recorder to the network folder Q:\QSFiles\Typists\<typistname>, then

Comment [LF1]: If the shared drive In
a network is F:, would a user have a
directory of F:\QsFiles and C:\QsFiles?
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set the Management Path to Q:\QSFiles\Management for all installations
of QS Recorder and QS Player.

IMPORTANT: The destination folders for your dictation files (where you will
SEND your dictation to be transcribed) are not specified in this panel, but are set
up in the actual ‘Send File to …’ entry panel.

Start Up

Display in detailed view

This option will display the Subject, Document name, number and Document
Type on the bottom of the main user interface.

Send Audio File As

The Quikscribe Recorder can send audio files as an “Intelligent Audio File” (.iaf)
or “audio only” (.wav) file.

If you use Quikscribe’s advanced .iaf format, all of the following information will
be sent within the audio file. Only the Quikscribe Recorder and Quikscribe
Player can open an .iaf file.

Audio content (dictation)
Text attachments
Graphics and screen shots
Other files or attachments
Database for management purposes
Author’s details
Typist’s instructions & notes

By selecting .wav format, only the audio content will be sent. If you wish to
create or send audio files to someone that does not have Quikscribe, you may
select to send a standard .wav file.
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Author’s Details

The Author’s Details tab enables the Quikscribe Recorder to automatically save
all contact details within every audio file created by the Quikscribe Recorder.

The contact details do not determine or affect file handling, but help the
transcriptionist to identify the author of the dictation file. The included author
details may not be needed in organizations where the author and typist are in
close contact with each other, but the details become important in large
environments where typing pools are used or when overflow dictation is
outsourced.

The author’s details available are:

 Title, First Name, Last Name
 Department, Floor
 Company, Location
 Address, Phone, Fax
 Email, SMTP Server, Port
 Secretary Email (for notification features sent to secretary)
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The panel contains a field to specify the user’s SMTP Server address for your
Internet Service Provider (ISP) since some ISPs require account authentication
to send outgoing email messages.

Voice Recognition

See the section Voice Recognition for detailed information about this feature.

Hotkeys
Quikscribe Recorder functions are usually managed with a hand control device
such as the Philips SpeechMike. Quikscribe Recorder also has the ability to be
controlled using keyboard “hot-key” strokes, which are defined in the Settings
panel. This provides greater flexibility to use other devices such as the
ShuttlePro. The hotkeys can be defined for ‘global’ actions (engaged for QSR
no matter what Windows application is active) or ‘local’ (engaged only if QSR is
the active application).

For example, if you press CTRL 6 you can create a Marker. If you press CTRL 7
you can create a Marker and Paste the contents of the Windows Clipboard (Text
or Screen Shot) into this Marker.
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Quikscribe
Function

Keyboard
Stroke

Global Local

Insert Blank
Marker

Ctrl + 6

Insert Marker &
Paste Clipboard

Ctrl + 7

Recording Mode Ctrl + Q
Beginning of File Ctrl + B
End of File Ctrl + E
Record Audio Ctrl + R
Stop Audio Ctrl + T
Open File Ctrl + O
New File Ctrl + N
Close File Ctrl + H
Send File Ctrl + G
Undo Audio Ctrl + Z
Redo Audio Ctrl + Y

Ctrl +
Ctrl +
Ctrl +
Ctrl +
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Ctrl +
Ctrl +

File Menu

The File Menu contains the features of the icons and includes several special
features that are not available through the icons of Quikscribe. These special
features are described below. The last file(s) that were open are listed at the
bottom of the File Menu.

Delete Audio: If you choose this feature with a file open, you may delete the
open file.

Protect Content: allows password protection for audio files. This is useful for
situations when the subject content is sensitive and designated to be opened
only by someone authorized with the correct password.

Save As: provides the ability to save the audio file under a new filename and
location.
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Send Pending Files: Selecting this will initiate the send function for files held
temporarily because the network communications had failed. Normally
Quikscribe will send the pending files automatically – this allows manual
intervention to send the pending files.

DPM files: If you use a Digital Pocket Memo (DPM) and you have the DPM
hooked to a USB port on your computer, selecting this feature will display the
files that may be downloaded from the Pocket Memo to your PC. You may
select any or all of the files to download.

Play/Record Levels: With this feature speaker volume and microphone volume
may be adjusted. When you select this feature a Volume Control panel will
appear with a slider to adjust speaker volume. To adjust microphone volume,
from the top of the Volume Control panel select Options Properties, your
microphone from Mixer Devices OK. A slider will appear to adjust
microphone volume. Make any volume adjustment needed and exit the panel.

Import Audio: You may import audio files created from other sources. You
will first need to create an audio file to import the desired file. You may now add
to the file that you imported.

Export Audio: You may export audio files to a .wav format to be played by
those who do not have the Quikscribe Recorder or Player.

Scan Import Folder: The Import Folder is the folder where files imported from
an external source are placed. Quikscribe will periodically scan this folder and
import files into the draft folder – this allows manual intervention to move the
imported files into the draft folder.

Export Markers: Allows you to export markers into files on your computer.

Import All Markers: Allows you to import an exported marker to a dictation file.

Change Profile provides a popup panel to select the profile of the Quikscribe
user. The profile contains all the user identification and personal system
settings. The 1st pull down box lists the names of the current profiles available.
The 2nd pull down box gives the option of loading or deleting a profile selected in
the 1st pull down box.

Profiles are generally used for environments where users are
sharing a dictation or transcription station. If you have need for a
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profile with specific settings or preferences, you may add a profile to
Quikscribe Recorder.

To create a new profile:

 Change whatever settings you prefer in the Recorder, then go to File –
Change Profile

 Type the name for the new profile. This will enable the ‘Add Profile’
button. In the example above the name for the new profile is ‘recorder 2’.

 Click the Add Profile button and the profile will be added.
 You will now have the choice of the prior profile named ‘Recorder’ and the

profile that you just created.

A profile is a text file that records your preferences and has the extension
.pfl. The profiles are stored in the ... c:/Documents and Settings/<user
id>/Application Data/Quikscribe/QSRecorder folder and can be
manually edited with a text editor such as Notepad (where <user id>
represents the user’s login id for Windows). For larger installations,
working with the profile files may ease the installation process. Please
contact support@quikscribe.com for more information.

If the .pfl file is deleted, the Quikscribe Recorder will automatically make a
new one using the default application settings.

Edit Menu

The Edit Menu provides several options available during recording:
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Undo Audit Edit and Redo Audio Edit are described in the section Undo

Dictation and Redo Dictation .

You may select Overwrite Mode, Insert Mode, or Append Mode from the edit
menu. You may also define in settings the default recording mode to be used
every time a new file is created.

Overwrite Mode is similar to recording using tapes – if you rewind to a previous
point in the file, new recording will overwrite the existing dictation.

Insert Mode will allow you to save the existing dictation, and insert new dictation
at any point in the file.

Append Mode ensures that recording content is not lost. If you rewind and
review the existing recording, then select ‘Record’, the position pointer will move
to the end of the existing file and commence recording at that point. If the same
thing were done in ‘Overwrite’ mode (as with a tape system) and the dictation
was not at the end of the file, then existing content would be overwritten.

Enable Real-Time Extract toggles the feature to send dictation immediately to
the transcriptionist.

This program is useful when you have an urgent dictation and you don't want to
wait until you've completed the dictation to send it for transcription. The Real-
Time Extraction program will send portions of your dictation file immediately to
your secretary or transcriptionist, based on the parameters you define.

For example, you've got an important case to dictate - it's the end of the day and
everyone's anxious to go home. You open the Real-Time Extraction program,
start recording as you usually do with the Quikscribe Recorder, and your
secretary starts typing while you're dictating. It's just that simple. The Real-Time
Extraction program is a separate plug-in for the Quikscribe Recorder. Please
contact support@quikscribe.com for more information.

Tip: You may assign the Undo, Redo, and Insert/Overwrite functions to a button
on your hand control device (such as the SpeechMike or Voice Input Station).
See the section,
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Hand Control Microphones, for more information.

Markers Menu

Quikscribe has the unique ability to embed markers at any point in the audio file,
in order to insert text, images, or file attachments. The advantage of this
powerful feature allows you to easily include a variety of supplemental
documentation with your dictation, and send it to your transcriptionist with the
dictation file.

Everything is compiled and presented in the order that you desire, so that it’s
clear what attachments are represented by the recorded dictation.

You may assign the desired marker function to a programmable button on the
hand control, if you plan to use the feature frequently.

Insert Blank Marker
Creates a marker with a date/time stamp. You may use the marker at a later
time to paste data from the Clipboard, or to insert a file into the marker. Pressing
CTRL-6 may be used for this function, also.

Paste Clipboard within Selected Marker
Will paste the clipboard contents into the marker. You may highlight text with
your mouse, and then use CTRL-C or right-click to copy the text, and then select
Paste Clipboard within selected Marker.

Paste Clipboard as Image within Selected Marker
Will paste the clipboard contents as an image into the marker. You may select a
Windows screen image your mouse, and then right-click to copy the image, and
then select Paste Clipboard as image within selected Marker.
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Import File within Selected Marker
Will prompt for a filename to attach to the marker. Provides the ability to attach
any Windows file within the audio dictation.

Export File from Selected Marker
Provides the ability to extract a file that was previously imported and attached to
a marker.

Clone Selected Marker
Duplicates the marker and its contents.

Insert Marker & Paste Clipboard
Creates a marker and automatically pastes the contents of the last Windows
Clipboard entry. Pressing CTRL-7 may be used for this function, also.

Insert Marker & Add Attachment
Creates a new marker and prompts for a file name to include as an attachment.

View Selected Marker
Displays the contents of selected marker.

Display Marker View Interface
Opens and closes the drop-down box for the markers.

Delete Selected Marker
Selecting this option deletes the marker. You may also press the Delete button
on your keyboard to delete a marker. Once a marker is deleted, it cannot be
retrieved.

Select screen region for capture from

The three markers, Record Mouse X, Y Position, Capture Screen Shot On
Record, and Set Screen Capture Region, allow you to specify a region of the
screen and capture the image as a marker in the IAF. This is a convenient
method for including visual examples with an audio explanation.

How to Insert Markers, Text & Screen Shots
The Quikscribe Recorder can insert marker files and within these marker files
you can add text attachments or screen shots. The main advantage of marker
attachments is to save time. Rather than dictate text from other documents or
web sites, you can select the text with your mouse and press CTRL C (which will
copy the selected text to the Windows clipboard) then paste this text within a
Marker file in your audio file.

To demonstrate:

 Create a New Audio File.
 RECORD “A B C D E”.
 Then open up an existing text or Word document (or something from a

Web page) and select some text within the document with your mouse.
 Press CTRL C (this will copy the selected text to the Windows Clipboard).
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 Now press CTRL 7 (this is the default Hotkey for the Quikscribe
Recorder). As a result, a Marker File containing the contents of the
Windows clipboard should be created within your audio file.

You may assign a button on the hand control to insert markers. Following are
the marker options available in the Hand Control Training for a programmable
button on the hand control microphone.

 Insert Blank Marker
 Insert Marker & Active or Full Screen
 Insert Marker & Add Attachment
 Insert Marker & Capture Active Window
 Insert Marker & Capture Full Screen
 Insert Marker & Paste Clipboard
 Insert Marker & Paste Image
 Insert Marker & Paste Plain Text
 Insert Marker & Paste Rich Text

All you have if you assign a button is highlight the text with your mouse or point
to a window or screen, and then press the function button to insert the marker
and copy the text or image to the marker.
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Help Menu

The features on the Help Menu are shown below and a description of each
feature follows.

Quikscribe Recorder Help
Provides basic online information and assistance for Quikscribe Recorder
features, including icons and menu options.

Hand Control Training
This is a powerful tool to set the functions and features for your specific hand
control microphone. You may access Hand Control Training through the Help
menu or through the Recorder Settings icon. Please see the section
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Hand Control Microphones for additional information about hand controls.

Recorder Tutorial
Starts the Quikscribe Recorder tutorial, which explains how the Quikscribe
Player works, and includes interactive exercises.

License Info
Provides information on the software registration license and attached hardware
used by the Quikscribe Recorder. After the Recorder has been registered the
license level will display Full Quikscribe Recorder License.

Web Registration
Used to provide software registration.

Request Email Support
Displays pop-up panel with entry fields so that you can describe a performance
issue with the Quikscribe software. Upon submission, the request will include
copies of the user profile and log file to assist with investigating and
troubleshooting the issue.

Log
Provides viewing access to activities log, and is useful for troubleshooting
performance issues if they arise.

About Quikscribe Recorder
Provides the version number for the software.



78

Examples

How to Record, Rewind and Play an Audio File
 Click the Create New Audio File Icon.
 Enter any file details that you wish to add e.g. Matter No, Subject etc.
 Click Create or press ‘Alt R’ on your keyboard. This will create your

new audio file. Click Cancel or press ‘AltC’ to CANCEL the creation of
the file.

 Slide to REC or hold down the REC button on the Quikscribe Hand
Control and speak to record. The microphone is built into the Hand
Control. To stop recording slide to STOP or release the REC button.

 Slide to F.RWD or press F.RWD to return to the beginning of the dictation.
 Slide to PLAY or press the PLAY button to hear what you have just

recorded. (If you cannot hear the recording, please refer to the video
demonstration on the installation CD, “How to Configure Windows Audio
Settings”.)

Note: For more information about how the Hand Control works, click on the Help
menu and then select Hand Control Training. This will display a training
presentation about the Hand Control.

How to Insert Dictation
The Quikscribe Recorder normally records in OVERWRITE mode, like a
traditional tape cassette recorder does. However, the Quikscribe Recorder can
also record in INSERT mode, which means you can insert additional dictation
within your existing recording (e.g. mid-sentence) rather than having to add
dictation at the end of your recording.

There are three ways to change the Recording mode from OVERWRITE mode
to INSERT mode.

 Use the INSERT button on the Hand Control (providing it is configured do
so under the Record Tab under the Settings Icon).

 Press the “Insert” key on your keyboard, which will toggle the record
mode from Overwrite Mode to Insert Mode and visa versa.

 Select the Edit menu and then select Insert or Overwrite Mode.

When you change the Recording Mode from OVERWRITE mode to INSERT
mode, the status bar at the bottom of the Quikscribe Recorder will update and
display which mode you are in. In addition, the indicator in the top left corner will
show “O” for OVERWRITE or I for INSERT.

To demonstrate inserting dictation, do the following:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record “A - B - C - D - E” in Overwrite Mode.
 Rewind to the beginning of the audio file.
 Change the Record Mode to INSERT mode by using one of the three

ways above.
 Record “1 - 2 - 3 - 4 - 5”.
 Rewind to the beginning of the audio file and press or click PLAY.
 You should hear “1 - 2 - 3 - 4 - 5 - A - B - C - D - E”.
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How to Insert Markers, Text & Screen Shots
The Quikscribe Recorder can insert marker files and within these marker files
you can add text attachments or screen shots.
The main advantage of marker attachments is to save time. Rather than dictate
text from other documents or web sites, you can select the text with your mouse
and press CTRL C (which will copy the selected text to the Windows clipboard)
then paste this text within a Marker file in your audio file.

To demonstrate:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record “A B C D E”.
 Open an existing Text or Word document and select some text within the

document with your mouse or with keyboard keys.
 Press CTRL C which will copy the selected text to the Windows

Clipboard.
 Now press CTRL 7. This is the default Hotkey for the Quikscribe

Recorder to paste a marker. As a result, a Marker File containing the
contents of the Windows clipboard will be created within your audio file.

 View the Markers panel to see the Marker that has been added.
 Click the Marker to select it. To view the Marker, double-click it or select

Markers from the top menu and select View selected Marker.

How to Attach Other Files or Documents
The Quikscribe Recorder can attach other files and documents within the audio
file. These files can then be extracted by the Quikscribe Player.

To demonstrate:

 Create a New Audio File by clicking on the Create New Audio File icon.
 Record some audio and then stop.
 From the menu bar select File and then Add Attachment.
 Using the Add Attachment dialogue box, browse your Hard Drive or

Network, select a sample file, and select Open.

At this stage, the file you selected should be attached within your current audio
file. In the bottom left hand corner of the Task Bar you should notice #1,
signifying that you have one attachment within the file.

If you want to Extract or Remove any attachments from within an audio file, do
the following:

 From the menu bar, select File and then View Attachment.
 Select the file you want to Remove or Extract.
 Then select either Remove or Extract.

.

How to Send Audio Files via the Network
Provided you have set-up Quikscribe correctly, it is very easy to send audio files
over the network. To send an audio file across the network:

 Finish dictating.
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 Click the Send Audio File Icon.
 Under the “Method Tab” make sure Network is selected. Select the

typist who will transcribe your dictation from the list of Typists. If your
typist’s name doesn’t appear in the list, refer to the section Setting Up to
Send Audio Files via the Network.

 Select the “Required In” time and “On Completion” notification.
 Click Send.

How to E-mail an Audio File
Quikscribe can e-mail audio files as attachments. Some Internet Service
Providers may require that you specify your SMTP address for outgoing mail. If
necessary, you may enter your SMTP address under System Settings
Author Details.

Before sending an audio file via e-mail it is recommended that your audio file be
compressed. Otherwise it can take ten times longer to send (and receive) the
audio file. Therefore, make sure “Real Time Compression” or “Post
Compression” is selected under the File Management Tab under the Settings
Icon.

To e-mail an audio file:
 Finish dictating.
 Click the Send Audio File Icon. *
 Under the “Method Tab” make sure E-mail is selected.
 Select an e-mail address from the list box. If the e-mail address you with

to select is not in the list box, refer to the section Setting Up to Send
Audio Files via E-mail.

 Select the “Required In” time and “On Completion” notification.
 Click Send..

How to Import another Audio File
To import an audio file with an extension, such as .wav or .dss, do the following:

 Click Create New Audio File icon
 Select File then Import Audio.
 In the Import Audio dialogue box, browse your Hard Drive and select the

audio file you wish to import.
 Once found and selected, press Open.

Quikscribe will then import the audio file (.wav or .dss) and at the same time
convert the file into Quikscribe’s .iaf format. While this happens a status box
appears showing the percentage completed. When you have finished dictating,
press the Send Audio Icon as you would with a normal audio file.

Importing Files from the Philips Digital Pocket Memo (DPM)
The Quikscribe Recorder has integrated software and hardware drivers to
support professional digital recorders from Philips, including models 9350, 9360,
9400, 9450 and 9600. The Quikscribe drivers provide a pop-up panel that
displays the list of files on the DPM unit, and allows you to easily transfer the
files to the Quikscribe Recorder or to the Quikscribe Player.
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When the DPM is connected to the PC using the USB cable or the docking
cradle, the “DPM Download Options” panel will appear, as in the following
example.

Before downloading review the options under the Settings menu at the top of the
download box. The recommended settings are to check Auto Display and
Send Using QSR Settings.

If the setting Leave Files on Device is checked the files will remain on the
memory card after download. You may want to check this option as you test
downloading files, but generally you would not check this feature since the
dictation files would accumulate on the memory card.

If Auto Display is checked, the “DPM Download Option” panel appears when
the DPM is connected to the PC. If Auto Display is not checked, the DPM
download may be opened from the taskbar by clicking the “DPM Download
Options” icon.

Notice in the files listed above in the “DPM Download Option” panel that one file
has “X” in the “EOL” column. EOL marked indicates that the author has pressed
the EOL (End of Letter) button on the DPM after recording a dictation. This
signifies that the dictation is finished. You may select individual files to transfer
to the PC by clicking anywhere on the line where the name of file is displayed, or
you may simply Select All” to mark all the files for transfer.

To download files if Send Using QSR Settings is checked:

Settings
Leave Files on Device

√ Auto Display
√ Send Using QSR Settings

Shutdown QSDPM
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 Select the item “To default location”.
 Now click on the “Download” button to transfer the files.
 Files with EOL marked will be sent directly to the Typist that last received

transcription on the recorder where the download occurs and will be
downloaded to the Sent folder of Quikscribe Recorder.

 Files with EOL not marked will be downloaded to the Draft folder of the
Quikscribe Recorder.

OR
 Select the item “Prompt for Location”.
 Now click on the “Download” button to transfer the files.
 Files with EOL marked will be sent directly to the transcriptionist that

last was sent a file on the recorder where the download occurs and will be
downloaded to the Sent folder of Quikscribe Recorder.

 Files with EOL not marked will be downloaded to the folder you chose
when prompted but will not be sent to the Sent or Draft folder Quikscribe
Recorder.

To download files if Send Using QSR Settings is not checked:

 Select the item “To default location”.
 Now click on the “Download” button to transfer the files.
 All files will be downloaded to the Draft folder of the Quikscribe Recorder.

OR
 Select the item “Prompt for Location”.
 Now click on the “Download” button to transfer the files.
 All files will be downloaded to the folder you chose when prompted but

will not be sent to the Sent or Draft folder Quikscribe Recorder.

Any file downloaded to the drafts folder of Quikscribe Recorder may be
reviewed, modified, and then sent to the transcriptionist. The QS Recorder
maintains a backup copy in the Sent folder, and the file is named according to
the naming conventions established in the File Management section of the
system settings. A file sent directly to a transcriptionist and also downloaded to
the Sent folder of Quikscribe Recorder has, of course, a backup copy maintained
in the Sent folder. Also the file is named according to the naming conventions
established in the File Management section of the system settings. A file sent
directly to a transcriptionist but not downloaded to the Sent folder of Quikscribe
Recorder does not have a backup copy maintained in the Sent folder. Also the
file is named according to the naming conventions established in the File
Management section of the system settings, but does not have the date and time
included in the name in Quikscribe Player.

Quikscribe Voice Recognition

This unique feature will automatically produce a draft text document, either
before or after the transcriptionist receives the audio file.
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Please note that “The Voice Recognition option should only be enabled if the
optional voice recognition software is installed and configured properly.
Otherwise files that are sent to transcription will not reach the intended
destination.”

The author’s style of dictation is not impacted by the Voice Recognition feature.
The author may dictate as usual using the Quikscribe Recorder and portable
recorders without changing speech pattern or tempo. When the file is sent to
transcription, Voice Recognition is triggered to interpret the audio file (according
to the appropriate user profile) and produce the draft text document. If the
author does not select Voice Recognition within Quikscribe Recorder, the
transcriptionist may enable Voice Recognition within Quikscribe Player. The
transcriptionist would need to employ the appropriate user profile when enabling
Voice Recognition for a file.

If you have Dragon NaturallySpeaking, files are processed in the background
with the Dragon NaturallySpeaking AutoTranscribe Folder Agent to produce a
draft text document. The transcriptionist will then review the document for
accuracy, making the necessary corrections in the word processor (or entry
screen) while listening to the dictation audio file.
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Transcription Agent

The AutoTranscribe Folder Agent must be open in order for Voice Recognition to
occur. Dragon NaturallySpeaking must be closed when the AutoTranscribe
Folder Agent is open. Voice Recognition can occur on the author’s PC, the
transcription PC, or a separate process server supporting multiple users.

The AutoTranscribe Folder Agent is of tool of Dragon NaturallySpeaking and
may be opened by clicking Start All Programs Dragon Naturally Speaking
 Dragon Naturally Speaking Tools AutoTranscribe Folder Agent. For ease
of use the AutoTranscribe Folder Agent may be either pinned to the Start Menu
or sent to the desktop. Opening the Agent will display an icon like the image
below in your system tray.

AutoTranscribe Folder Agent.lnk

Selecting open again will display the Agent panel. An image of the panel is
shown on the following page.

A task must be defined for the Agent to synchronize with Quikscribe. The image
of the Agent on the following page shows one task. To define a task for the
Agent to coordinate with Quikscribe please follow the steps below. The steps
that are described below assume Voice Recognition occurs on the author’s or
the transcriptionist’s PC. See the section below regarding network setup if
Voice Recognition occurs on your network drive.

AutoTranscribe Folder Agent Task for Voice Recognition Occurring on
Author’s or Transcriptionist’s PC

o Open the Dragon Naturally Speaking AutoTranscribe Folder Agent.
o Select Task New.
o Set the Input directory to C:\QsFiles\VR\Input.
o Set the Output directory to C:\QsFiles\VR\Output.
o Set the User Location to:

C:\Documents and Settings\User\Application
Data\Nuance\NaturallySpeaking9\Users\

This is the default setting, so clicking the default button will insert
this User Location.

o Choose the Dragon NaturallySpeaking User Name, Vocabulary, &
dictation source that will be used with Quikscribe.
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Selecting Voice Recognition in Quikscribe Recorder

Within Quikscribe Recorder the Voice Recognition option may be selected when
a file is created, when a file is sent, or as a default setting for all audio files. The
default method would be used only if the author wishes to always enable voice
recognition. The panels in Quikscribe Recorder where Voice Recognition may
be selected are shown below. Remember to have the AutoTranscribe Folder
Agent open when performing Voice Recognition. The transcribed text is not
visible to the author in Quikscribe Recorder but will be visible to the
transcriptionist in Quikscribe Player via a marker embedded in the Intelligent
Audio File.

 Voice Recognition may be selected when the file is created in the New
Audio File panel. The image below shows Voice Recognition checked.

 Voice Recognition may be selected when a file is sent in the File Details
tab of the Send to panel. The image below shows the Voice Recognition
option is selected in the Send File panel under File Details.
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 Voice Recognition may also be selected as a default setting for all
dictation files in the Voice Recognition tab of the Settings panel. The
image below shows the Voice Recognition option is selected as a
default for all dictation files.
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Quikscribe Player Text Production if Voice Recognition is Performed in
Quikscribe Recorder

The draft document is produced automatically in Quikscribe Recorder. Dragon
NaturallySpeaking produces the text file, and Quikscribe merges the text back
into the Intelligent Audio File as the contents of a marker.

 The transcriptionist receives notification of a new dictation audio file. The
Quikscribe Player alerts the transcriptionist a new file has arrived and is
ready to be transcribed, including priority notification if selected by the
author.

 The marker table in the bottom portion of the QS Player displays the list of
markers in the file. The first marker shows content labeled “Voice
recognised text”, indicating the marker contains text generated by the
voice recognition process. See the image below with a marker labeled
“Voice recognized text.”

 When playing the audio file, the QS Player provides an audible alert that a
marker is present. By simply pressing CTRL-V, the contents of the
marker are pasted automatically into the word processing document.

 The transcriptionist then listens to the audio file and makes the necessary
corrections on the screen.
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Performing Voice Recognition in Quikscribe Player

Voice Recognition may occur in Quikscribe Player instead of Quikscribe
Recorder. If Voice Recognition occurs in Quikscribe Player, the author does not
need to choose Voice Recognition when dictating a file. The transcriptionist
would follow the steps below to perform Voice Recognition in Quikscribe Player.
Remember that a task must be defined in the Dragon Naturally Speaking
AutoTranscribe Folder Agent for Voice Recognition to occur.

 Open Dragon Naturally Speaking AutoTranscribe Folder Agent.
 Open Quikscribe Player.
 Open a dictation file that is waiting to be transcribed.
 Click Quikscribe Settings Voice Recog. See the image below.

o Check “Wait for Voice Recognition” to wait for Voice
Recognition to complete, so you can continue working
with the file.

o Leave “Wait for Voice Recognition” unchecked to not
wait for Voice Recognition to complete. You may close
the current file and open another file and perform Voice
Recognition on the second file. Voice Recognition may
be performed in the background as you complete other
dictation or tasks.

 Select File Perform Voice Recognition.
 Now either (1) wait for Voice Recognition for the current file or (2) close

the current file and then open another file and Perform Voice Recognition
on that file. Voice Recognition is complete when the state of the Auto
Transcribe Agent is Idle.
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 When Voice Recognition is completed, click the drop-down arrow under
the Volume Meter. You will see a marker with label of “Voice recognised
text”. See the image below.

 If a word processing document didn’t open automatically, click the word
processing icon in Quikscribe Player, so a new document will be open for
your transcription.

 Play the dictation file in Quikscribe Player.
 After hearing the musical prompt, place the cursor at the beginning of the

word processing file.
 Now press Ctrl V, which will paste the contents of the Voice recognized

text marker in the word processing document.
 Continue playing the dictation and edit the Voice recognized text.
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Voice Recognition Folders and Users for Network Environment

Use My Computer in Windows to go to your Quikscribe shared folder on your
network drive (such as F:\QsFiles). This shared folder is usually named
“QSFiles”.

Create Quikscribe folders
 Within QsFiles create a subfolder called \QSFiles\VR
 Within VR create three subfolders: INPUT, OUPUT, and PROFILE.
 Once completed your file structure should look like this.

Set Quikscribe Paths
 Open Quikscribe Recorder. Go to Settings Voice Recognition.

Browse to set the VR Input and Output Path to the files you created on
your network drive. Set the VR Input Path to [Network
Drive]\QsFiles\VR\Input. Set the VR Output Path to [Network
Drive]\QsFiles\VR\Output. No entry is required at this time in the VR
Profile Setting. Close Quikscribe Recorder.

 Open Quikscribe Player. Go to Settings Voice Recognition. Browse to
set the VR Input and Output Path to the files you created on your network
drive. Set the VR Input Path to [Network Drive]\QsFiles\VR\Input. Set the
VR Output Path to [Network Drive]\QsFiles\VR\Output. No entry is
required at this time in the VR Profile Setting. Close Quikscribe Player.

Import DNS User
 Open Dragon NaturallySpeaking.
 Select NaturallySpeaking Manage Users.
 Point to your user. Select Advanced Import. Browse to [Network

Drive]\QsFiles\VR\Profile. Profile should display in the box opposite
Folder:. Click OK.

 In the Manage Users panel of Dragon NaturallySpeaking set the Location
of user files to [Network Drive]\QsFiles\VR\Profile.

Define AutoTranscribe Task
 Open the Dragon Naturally Speaking AutoTranscribe Folder Agent.
 Select Task New.
 Set the Input directory to [Network Drive]\QsFiles\VR\Input.
 Set the Output directory to [Network Drive]\QsFiles\VR\Output.
 Set the User Location to [Network Drive]\QsFiles\VR\Profile.
 Choose the User Name, Vocabulary, & dictation source that you will be

using with Quikscribe.
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File Management and Management Option

Quikscribe Recorder and Quikscribe Player have an integrated file management
agent that updates file properties to track progress of work-in-progress. This
feature is accomplished real time without using an external database
engine. You can easily check on files to see if they’ve been completed (or how
much of the file is completed), where it was sent, and who worked on the file and
for how long. Using this foundation, future enhancements will include a central
control console for enterprise management and reporting. This method works
for files sent using both Network and FTP methods.

The “Management” option must be selected and installed during the
Quikscribe Recorder installation process, and the Management Folder
must be defined under Settings > File Management to a shared network
folder (such as “Q:/QsFiles/Management”) to save the .imf management
files. These files retain the statistics and characteristics of the file and the
workflow progress.

File Properties
You may view file properties for the Intelligent Audio File (IAF) from within My
Computer (or Windows Explorer). By right-clicking on an IAF you may select
Properties and view all file details by Author and Typist. Everything pertaining to
the dictation and transcription activities is easily accessible, including progress of
the file, history of who opened and worked on the file, and captured billable
time. With any other type of audio file, all you’ll see under Properties is the
“General” tab, which gives you very basic information such as when the file was
created. With the IAF, you’ll get two additional tabs - “Author” and “Typist”.
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General Tab

Author Tab

The Author panel provides all the pertinent information about the IAF
surrounding the Author’s perspective of creating and sending the dictation file to
transcription. Click on the Author tab, and this is what you’ll see:
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Typist Tab

Clicking on the Typist tab provides details on the transcription perspective:
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Open IAF file from My Computer or Windows Explorer

File Properties - double-click to open: From within Windows Explorer (or My
Computer) you can browse to a folder and open an IAF file directly by double-
clicking the file. The file will open with the default program assigned (QSR or
QSP). You may also right-click on the file, and then select the desired option:
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Add Attachments and Markers to IAF file from My Computer or Windows
Explorer

File Properties - Add Attachment (QSR): You’ll also notice the new options to
instantly create a new IAF file and add a file as an attachment. Just right-click
on ANY file in Windows Explorer, then select “Add As Marker Attachment to
IAF”. QS Recorder will initiate and create a new file, and automatically include
the selected file attachment. You can also right-click on any Windows file and
add it as an attachment to your dictation file. The IAF is now recognized under
Windows (outside of the QS Recorder and QS Player interface).
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